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By the end of this class, you will know how to: 

Å use PowerPoint menus 

Å create a new slideshow 

Å add new slides 

Å add images, movie clips, text 

Å manipulate objects 

Å add backgrounds 

Å change views 

Å use slide transitions 

Å save your slideshow 

 

 

What Is PowerPoint?

Microsoft PowerPoint is a commonly used presentation program used in business, 

education and training. PowerPoint allows you to add multimedia elements to a 

slideshow presentation including vision, sound and video. 

 

 

Opening PowerPoint 

1. Click on Start 

 

2. From the Start menu, click on All Programs 

 

3. Click on Microsoft PowerPoint 

 

  



 

Introduction to PowerPoint                                                 Brimbank Libraries  

 

 3  

 

The PowerPoint Window 

 

 

 

 

Creating A New Slideshow Using A Template 

1. Open PowerPoint. A blank presentation will open. The New presentation pane is 

displayed on the right side of the screen. 

 

2. Select the Design ribbon bar 

 

 

Select a template from the Themes. Watch your slide preview update.  

Click on the dropdown arrow to view more templates. 

 

Menu bar  

Ribbon bar  

Slide preview  

Slides 

layout 

pane  

Presentation notes  
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3. If you would like to use another template, just select another template and the slide 

preview will update accordingly 

 

 

3. Click in the space labelled Click to add title . Type your name. 

 

4. Click in the space labelled Click to add subtitle . Type All about me. 
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Adding A New Slide 

Under the Home Ribbon bar: 

1. Click the New Slide button  

 

 

2. A new blank slide will display.  

Select the Content with Caption for this slide with the Layout button

 

 

4. Click in the area that says Click to add title . Type My Favourite Animals. 

 

5. Click in the area that says Click to add text . Type three of your favourite animals. 

 

Adding An Image 

If you have a slide layout that has a place for an image to be inserted, you can easily add 

an image (or other type of multimedia) by clicking the appropriate icon: 

 

 

 

 

 

Insert 

Table  

Insert 

Image  

Insert Chart  

Insert Smart Art  

Insert ClipArt  

Insert Media Clip  
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Adding A Clipart Picture 

 

1. Click the Clipart Picture icon    

 

 

 

 

2. The Insert Clip Art pane will display 

 

3. In the search text field, type the name of  

one of your favourite animals 

 

 

 

 

 

 

 

 

 

 

 

 

4. You can limit your search results to a particular type (e.g .only photos, or only 

clipart) by clicking the Results should be drop down menu and ticking the type of 

images you would like to see. 

 

5. Click Go to search 

 

6. A list of results will display. When you find the picture you want to use, click  on it 

to place it into your presentation. 
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Adding A Picture From A File 

 

1. Click the Picture icon from the Insert ribbon bar 

 

 

 

2. Using the Insert Picture pop-up window, find the picture on your computer or disk 

 

3. Select the picture and click the Insert button 

 

Adding a Movie Clip 

You can add a movie clip to your presentation from the Movie Clip Organiser or as a file 

on your computer. 

 

Adding a Movie Clip from the Movie Clip Organiser 

1. Click New Slide to add a new slide to your presentation 

 

2. Click in the area that says Click to add title . Type My Favourite Music. 

 

3. Click in the area that says Click to add text . Type three of your favourite bands or 

musicians. 

 

2. Click on the Insert Ribbon bar  

 

 

3. Click on the drop down arrow beneath Video  

4. Click on Clip Art Video 

5. The Clip Art pane will display on the right with a list of movies available 

6. Click on the movie you want to insert it into your presentation 
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Adding A Movie Clip From A File 

1. Click on the Insert menu at the top of the screen  

 

2. Click on Movies and Sounds 

 

3. Click on Movie from File 

 

4. In the Insert Movie pop-up box, find the movie you want on your computer or disk 

 

5. Select the movie and click the Insert button 

 

6. When PowerPoint asks Do you want your movie to play automatically in the 

slide show?, click Yes.  

 

If you choose No, you will need to click on the movie to play it when you are viewing 

the slideshow. 

 

Adding Text 

You can add an additional text area to a slide at any time using the text tool. 

 

1. Click on your favourite animals slide in the Slider layout Pane on the left side of 

the screen 
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2. Under the Insert ribbon bar, select Text Box 

 

 

 

3. Click and drag the mouse cursor underneath the  

picture of the animal 

 

 

4. A text box will appear. Type a short description of  

the picture. 

 

 

 

Formatting Text 

You can change the look of the text inside the box by using Font and Paragraph section 

under the Home Ribbon Bar 

 

 

 

 

¶ Adds a shadow to the text in the text box  

 

¶ Increases or Decrease the size of the text in the text box  

 

¶ Changes the colour of the text, to the stripe of colour displayed under the A. To 

select a new colour, click the arrow next to the A. 
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Formatting Text Boxes 

 

1. Select the text box you would like to format. You will notice a new tab will open up in the 

top ribbon called Format under Drawing Tools 

 

 

 

Changes the background colour of the text box to the stripe of colour displayed under 

the paint can. To select a new colour, click the arrow next to the Shape Fill. 

 

Shape Outline changes the border colour of the text box to the stripe of colour displayed. 

To select a new colour, click the arrow next to Shape Outline 

 

 In the Shape Outline menu > you can changes the thickness of the border with Weight 

 

 In the Shape Outline menu > you can changes the style of the border with Dashes 

  

Shape Effects will give some add some cool effects to your text. Try out some different 

effects. 

 

 

 

1. Click on the text box underneath the animal 

picture that you just created 

 

2. Click on Shape Fill and change the 

background to white 

 

3. Click on Shape Outline to change the border 

to red and the Weight to 21/4 pt 

 

4. Highlight the text by clicking and dragging 

over the words. 

 

5. Click on the arrow on the font colour icon  

to change the text to blue. 
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Moving, Resizing And Rotating Objects 

You can move, resize and rotate any object (text box or image) that you place on a slide. 

 

1. Before you can move, resize or rotate an object you must first select the object by 

clicking on it once 

2. When the object is selected, you will see handles to show you that it is selected 

 

3. You can move or resize many objects at once by clicking and dragging a square 

with your mouse around the group of objects you want to move 

 

Moving An Object 

1. Click on the object 

2. Move your mouse over the object until it turns into a 4 sided arrow (you will need 

to hold your mouse over the border of text boxes) 

3. Click and drag the object to the position you want it 

 

Resizing An Object 

1. Click on the object 

2. Move your mouse over one of the resize handles of the object 

3. Click and drag the object to the desired size 

 

Rotating An Object 

1. Click on the object 

2. Move your mouse over the green rotate handle 

3. Click and drag to rotate the object to the desired angle 
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Changing Slide Backgrounds 

You can change the background for individual slides or all the slides in your presentation. 

You can have a plain coloured background, gradient background, textured  background, 

or a picture or photo as your background. Remember that when you choose a 

background, the text and content on your slide needs to be easy to see and read. 

 

1. Click on Design tab on the top ribbon  

 

 

 

2. Click on Background Styles. 

 

3. Hover over styles to preview. Confirm your selection by clicking on it  

 

 

4. For more options on background styles select the Format Background  button in 

the Background Styles  menu  
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Format Background window 

 

 

Gradient 

The Gradient fill lets you to add a gradient background that fades between two colours,  

in various directions or patterns.  There are a number of settings you must select when  

adding a gradient background. Play around the various settings and see what happens to 

your background.  

 

How to use the Gradient Stops tool 

 

 

 To change the colour of a marker on the slider: 

1. Select a marker (It will then be highlighted orange) 

2. Select the Color icon and choose a colour. 
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¶ Add an extra marker into the slider by clicking on an empty space between 

markers. 

 

¶ Remove a marker by clicking and dragging an existing marker away from 

the slider 

  

¶ Transparency ð Will fade out the marker colour that is selected 

 

¶ Direction - Choose the direction  you want the gradient to go in.  This works 

together with Angles. 

 

¶ Type ð Effects the way your gradient looks in the background 

 

Picture or Texture fill 

This lets you choose a texture 

square to ôtileõ across the entire slide 

background or an image.  

 

 

 

 

 

 

 

 

 

 

Patterns 

The Patterns tab lets you add a colour  

pattern to your slide backgrounds.

PowerPoint has a range of patterns to choose  

from. You can choose the foreground and 

the background colours of the pattern. When 

choosing patterned backgrounds, make 

sure you can still read the text on your slide. 
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Views 

Under the View tab in the top ribbon, you can view your slideshow in different ways. The 

default view is the Normal view.  

 

 

 

Normal 

The normal view is used for editing the content of your slide and viewing a single slide 

in edit mode.   

¶ Click View and click Normal or  

¶ Click at the bottom left corner of your screen      

  

Slide Sorter 

The slide sorter view displays thumbnails of all the slides in your presentation in the 

order which they will appear 

Slide sorter view is used to change the order of the slides in your presentation, as well as 

to add transition effects between slides 

¶ Click View and click Slide Sorter or  

¶ Click at the bottom right corner of your screen    

  

Slide Show 

Slide show view is used to watch your slideshow as it will look on a full screen when 

you have finished.  This is often useful when applying transitions and animation to 

your slides. You can make sure that the timing of the presentation and the order of 

the slides follows the flow of your presentation 

 

¶ In the top ribbon click on the Slide Show tab  

Select the From Beginning button to view your slides in a presentation   

 or click  at the bottom left corner of your screen 

 or press F5 on your keyboard 
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Notes Page 

¶ Notes are for the presenter and do not display on the screen with your 

presentation 

¶ If you are adding notes to your slideshow, you can see what they will look like in 

printed form with this view 

¶ Click View and click Notes Page 

 

1. Add a new slide to your presentation 

2. Title it Favourite Holiday Destinations 

3. List three favourite holiday destinations and add a picture 

4. Preview your slideshow in slideshow mode (press F5 on your keyboard) 

 

Slide Transitions 

 

Slide transitions can make a presentation more exciting and make slides feel like they 

flow together better. Although you can apply slide transitions in Normal View, it is often 

easier to apply them in Slide Sorter View. 

 

1. Click View and click Slide Sorter 

 

2. Click on the first slide  you wish to add the transition to 

 

3. In the top ribbon bar, select the Transitions tab 

 

 

 

4. Click on the down arrow to view more Transition effects 

 

5. Once an effect is selected, you may change   

how a transition effect looks through the  

Effects Options. Preview your effects live in  

the slide preview window.  
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¶ Duration ð Changes the speed of the transition 

 

5. Under Advance Slide:  

On Mouse Click - If you want to 

click the mouse to move on to 

the next slide 

 

Tick After and choose a number of seconds/minutes if you would like the slide 

to stay on screen before moving on to the next slide automatically 

 

7. If you want to apply this transition to all the slides in your presentation, click the 

Apply To All button 

 

8. Press F5 to view your slideshow 

 

Custom Animations 

Custom animations let you animate individual objects within a slide. You can use custom 

animations to achieve effects such as having a title fly onto the screen, or having dot 

points appear one at a time on a single slide as you talk about them. 

 

Adding An Animation 

To animate one or more elements on a slide: 

 

1. Click on View and click on Normal View 

 

2. In the Slide Sorter pane on the left, click on the slide that you want to add the 

animation to 

 

3. Click on the object (text or picture) that you want to animate 

 

4. Click on Animations tab at the top Ribbon Bar 

 

 

 

5. Click on Animation Pane, the Animation pane will open on the right. View all the 

animations in that slide in this window pane. 

 


